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Mobile Cloud Computing - Small Business, Midsize Business and Non-Profits. 
Mobile cloud computing uses cloud computing to deliver applications to mobile devices. These mobile 

apps can be deployed remotely using Speed and flexibility and development tools. Cloud applications 

can be built or revised quickly using cloud services. They can be delivered to many different devices with 

different operating systems like (Microsoft Cloud Services / Microsoft Azure).  

Why cloud computing for small businesses?  

Because it's the best thing for small business since the creation of the stapler. Cloud computing can give 

you access to your business data and applications from anywhere at any time from any mobile device, at 

a reasonable price. The cloud gives small businesses access to technologies that previously were out of 

their reach and lets them compete with both other small businesses and larger ones. 

 

The mobile revolution has reached mom-and-pop shops. According to Intuit study, 64% of small 

businesses across the US, Canada, Australia, and the UK now run their operations in the cloud. 

They predict that 80 percent of small businesses will be on the cloud by 2020. The cloud is redefining the 

way small businesses do business. Here are four reasons small-business owners should consider 

migrating to the cloud: 

 

1. Lower costs 

One of the most obvious benefits of moving everyday business to the cloud is that it can provide small 

businesses with significant savings.  

2. Better collaboration 

This is made easy in the cloud. The ability to save and access various files through the cloud enables 

employees to easily work from the same master document. Cloud collaboration tools, such as Microsoft 

Office 365 / Microsoft 365, allow users to upload, edit and comment on documents, which makes for 

better workplace collaboration. Additionally, employers can opt to limit what employees can access. 

3. Increased flexibility 

One of the most alluring benefits of cloud computing is being able to access work-related files and 

information from any device in any place at any time. We live in a mobile world. Long gone are the days 

where files are stuck on a single server on a single computer. 

4. Greater integration 

Adopting a cloud-based business solution creates multiple opportunities for integration -- and simplified 

integration, at that. Cloud-adapted small businesses have the option of integrating with various cloud-

based providers. Small businesses can take advantage of specialized services that integrate with back-

office operations, from human resources to marketing to accounting. These opportunities for 

integration give small-business owners more time to focus on the more critical areas of business. 

 

Have you made the move to the cloud? We can help you. Contact us today! info@btpsonline.com  

Tel: 1-269-501-7938- https://btpsonline.com/cloud-services   

mailto:info@btpsonline.com
https://btpsonline.com/cloud-services
https://btpsonline.com/
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The Mobile Cloud Book  

Mobility takes business out of the office 
A Small and Midsize Business Guide on Microsoft Cloud Computing 
 
Featuring: 
Microsoft Office 365 
Microsoft 365 
Microsoft Azure 
Brought to you by Microsoft and BTPS. 

 

Microsoft Office 365 Business Premium 
You and your team are likely some of the 1.2 billion people worldwide who 

have used Office 365. You’re familiar with standard apps like Word, Excel, 

Outlook, and PowerPoint. But when it comes to your business’s ever-

changing needs and challenges, there’s more to Office 365 than meets the 

eye. 

With premium versions of Word, Excel, and PowerPoint, along with a user 

interface optimized for Android or iOS phones or tablets, Office 365 lets your 

team perform at their best, whether in or out of the office. 

Mobility takes business out of the office 

 

Microsoft Office Word 

Add comments in Word via your phone 

Need to give feedback to a colleague while commuting? Edit documents on 

your Android or iPhone with the Word mobile app. 

To add comments. 

Tap anywhere in a document, then click Edit.  

Type your comments. If this is your first time adding a comment, you’ll be 

asked to enter a username so other people know 

who edited the document. 

Microsoft Office Excel 
Four team-friendly Excel shortcuts  

Think Excel is a desktop-only program? Think 

again. You can do just about everything in Excel on 

your smartphone or tablet. 

 

1. Formulas 

Calculate formulas on the mobile app by tapping 

the Formulas tab 

2. Easy access to your files 

Save Excel files to OneDrive and access them quickly on any device. 
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3. Built-in keyboard 

Add formulas with ease with your tablet’s onscreen keyboard. 

4. Recommended charts 

Quickly visualize data with a few taps of a finger with the 

Recommended Charts feature, perfect for smaller screens. 

PowerPoint 
Mobile PowerPoint has its perks 

Prep and present on the go 

Need to fix something on the way to a presentation? Use the 

PowerPoint app to make changes from your smartphone or tablet. 

Keep notes at your fingertips 

Read presentation notes directly from your phone. 

Cut the cords 

No need for bulky laptop cords and cables. Presenter View gives 

you full control over what your audience sees, showing speaker 

notes only on your tablet. New ink, laser pointer, and highlighting 

features help emphasize key concepts as you present. 

Know your talking points 

Ink your notes to help emphasize key points. 
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OneDrive 

Sharing made easy 
 

OneDrive enables effortless access to files, so you can work from anywhere and share your work with 

your team, wherever they are. Preview more than 270 common file types, including PDFs, Photoshop 

PSDs, Illustrator AIs, Visio files, DICOM 

medical images, and more. Even stream video on demand without waiting for it to download. 

Confidently share your files knowing others will be 

able to access them seamlessly and securely. Share a 

file or folder with specific people or send a link that 

gives access to anyone who needs it, inside or 

outside your organization. In addition, you can 

control how long a link provides access, and you can 

easily view and modify permissions you have 

granted. 

Microsoft Teams 
Communicate in real time 

For the increasing number of organizations that can’t 

always get everyone in the same room, Teams 

provides a rich and immersive meeting experience 

where workers can add Office files—such as PowerPoint 

documents with animations—via desktop or mobile for 

calls or chat. 

Sway 
Create beautifully on the go 

Sway makes it quick and easy to create and share polished, interactive reports, presentations, personal 

stories, and more, all from your mobile device. Add your content, and Sway does the rest. 

Create quickly 

• Start a Sway from photos on your mobile device. 

• Start a Sway by choosing a template. 
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• Access your content anywhere and continue to edit your 

previous Sways while on the go. 

Work on Sways with others with minimal effort 

• Coauthor with others near you using your iPhone. 

• Share an edit link with anyone to give them access to the Sway 

on their mobile or desktop device. 

Easily add content 

Use any photos or videos from your mobile device. 

Share with ease 

Every Sway is integrated with mobile share options. Just send a link 

to someone—they’ll be able to view your creation without signing 

up or downloading additional software. 

Yammer 

Connect top to bottom 

Yammer allows you to bring your whole workforce  

together—from the CEO to the firstline—to engage,  

share, and drive transparency, no matter where you are  

in the organization or the world. 

Outlook 
Tips for sharing attachments 

Outlook 2016 makes sharing files easier with an improved 

attachment experience. 

Upload attachments for easy sharing 

You can send files as traditional attachments or upload them right 

from Outlook to OneDrive or a SharePoint team site, letting 

everyone access, view, and edit the same version. 
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1. Connect your workplace SharePoint delivers connected 

experiences that empower people to share their expertise 

and work together with the files, data, conversations, and 

notes they need. 

2. Start your day on SharePoint’s home page, where you 

can see, at a glance, the recent activity of your teams. Get 

to work quickly with easy navigation to your sites and get 

a view of what’s important now. 

OneNote 

Never miss a note 

Taking notes on every important part of a meeting can be 

a little overwhelming. With OneNote 2016, you can invite 

others to a shared notebook by choosing File > Share > 

Invite People. To share a notebook during a meeting, choose File > Share > Share with Meeting. 

After others in your team open the notebook, anyone with permissions can add meeting notes 

simultaneously, which then sync automatically. 

 

 

 

SharePoint 
Two things to get you excited about SharePoint 

Whether you’re teaming up on a new product strategy, a sales presentation, or a key company initiative, 
SharePoint keeps content at the center of teamwork. Files, sites, and content are easily shareable and 
accessible across teams and organizations. 
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Office 365 Security 

 

Use mobile device management for Office 365 to secure and manage the following types of devices: 

• Android 4 or later versions 

• iOS 7.1 or later versions 

• Window 8.1 

• Windows Phone 8.1 

• Windows 8.1 RT 

• Windows 10 

• Windows 10 Mobile 

Mobile device management protects a range of Office 365 products, including: 

• Exchange  

• Excel 

• OneDrive 

• Outlook 

• PowerPoint 

• Sway (iOS only) 

• Word 

 
 

https://btpsonline.com/


8 

 

Microsoft Cloud Services – BTPS Solutions 

 
 

Microsoft 365 & Office 365 - BTPS Solutions: 
BTPS Cloud Solutions for Small, Midsize Businesses and Enterprise    

 
Connect with BTPS a Microsoft Partner and Cloud Services Advisor to find out how you can leverage 
your Public, Hybrid, or Private Cloud solutions into reality, in your organization today!    
Sign up Today! and get one year free advisory on all Microsoft Cloud Services, and up to 50% off on 
implementation. 

BTPS Takeoff >>>   BTPS Takeoff Cloud and Migration Services:  
Office 365 Online - Complete implementation for SMB. 
Migration of your on-premises data to cloud applications such as:   
Exchange Online, SharePoint Online, Microsoft Dynamics, Microsoft Teams.  SharePoint / SharePoint 
Online. 

Let us help you with a free trial (No Service disruption with your current 
services). 
 

Office 365 Trial Offer 
Business Technology and Payment Solutions, LLC (BTPS) 

Tel: 269-501-7938 

Microsoft Solutions Provider  

Email: info@btpsonline.com 

Website: www.btpsonline.com  

Your Privacy 

Disclaimer: 

Microsoft and all respective products and services are the work of the respective copyright holders.  

 

 

 

https://portal.office.com/partner/partnersignup.aspx?type=Trial&id=b4a26990-ea2a-4a81-b3ce-03fcd57f630a&msppid=2708615
https://www.microsoft.com/en-us/solution-providers/partnerdetails/business-technology-and-payment-solutions_159330a1-7822-47d4-8b34-20528aca7e60/87a507fb-4a84-46a4-98bf-bbad37e35a1f
mailto:info@btpsonline.com
http://www.btpsonline.com/
https://btpsonline.com/privacy
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Microsoft 365 Business 

Achieve more in your business with an integrated security, management and productivity solution 

— all in one. 

 

Now, for the first time, Microsoft is offering an integrated solution that brings together the 

productivity of Office 365 with the security of Windows 10. This cost-effective, subscription-based 

cloud service is built especially for small and midsize businesses like yours. It empowers your team 

to be productive every day with Office 365, no matter their locations. Plus, you can use Windows 10 

Pro to manage controls with automatic updates to securely protect your company’s data across 

devices — all from one simple administrative console. 

 

Achieve more together Create, connect and collaborate with people inside and outside of your 

company. 

 

Anywhere it matters Enable your people to be productive anywhere, on their favorite devices. 

Always-on security Help protect your data and devices through one simple dashboard that is always 

up-to-date. 

Simplified for business Manage your IT services quickly and easily so you can focus on what matters 

 

Always-on security Help protect your data and devices through one simple 

dashboard that is always up-to-date. 
Mobility takes business out of the office. 
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Microsoft 365 Business includes all the security features of Windows 10 Pro, including Windows 

Defender Management Controls, which allow you to manage your security controls within one product. 

This will help you gain peace of mind with a consistent set of security settings designed for your 

business. With automatic and universal enforcement of policies, your business’s risk profile will be 

lowered, even across personal devices that employees use for work. 

 

Microsoft 365 Business is an integrated solution built especially for small and 

midsized businesses. It’s powered by the productivity apps of Office 365 and the 

best in-class security features of Windows 10 to provide the technology you 

need to run and grow your business: 

• The familiar and powerful productivity and communication tools of Office 365, including Word, Excel, 

PowerPoint, Outlook, Teams, SharePoint and more 

• Centralized user, device and app management capabilities previously available only to large 

enterprises, but on an easy-to-use console for organizations with limited or no IT staff 

• Best-in-class security and control 

As a subscription service, Microsoft 365 Business has cost-effective pricing, while ensuring that you and 

your employees are always working with the latest and most secure version of Windows 10 and Office 

365. It is designed to be run by you or a trusted partner, so you can save on capital expenses, scale as 

you grow, and get the IT expertise you need to run your business better.  

Microsoft 365 Business or Office 365:  

Which solution is right for you and your business? 

Business Technology and Payment Solutions, LLC 

www.btpsonline.com  

Tel:269-501-7938 

info@btpsonline.com  

BOOK NOW! FREE  SERVICE AND CONSULTATION  
Contents provided by Microsoft and Btps  

Your Privacy 

Disclaimer: 

Microsoft and all respective products and services are the work of the respective copyright holders.  

http://www.btpsonline.com/
tel:269-501-7938
mailto:info@btpsonline.com
https://btpsonline.com/booking-btps
https://btpsonline.com/privacy
https://btpsonline.com/

